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1.  Introduction 
 

1.1 Add-on Module RSBUCK 

The RSTAB add-on module RSBUCK performs an eigenvalue analysis for frameworks to deter-
mine the critical load factors and buckling shapes. The critical load factor (critical buckling load 
factor of the entire system) allows you to evaluate the stability failure of the structural system. 
The corresponding buckling shape indicates the area that is prone to instability in the struc-
tural model. 

With the add-on module RSBUCK, you can analyze several buckling shapes simultaneously.  
After the calculation, the program shows the relevant failure modes of the RSTAB model, sort-
ed by the critical load factor. The corresponding buckling lengths and buckling loads are nec-
essary for the further stability calculations which, as a rule, must be performed for structural 
parts subjected to compression. 

In the graphical display of the buckling shapes, you can localize the areas in the model that are 
prone to instability. It is possible to derive structural measures in order to deal with the modes 
of failure. For these reasons, RSBUCK is a highly useful tool for analyzing systems susceptible to 
buckling, for example a slender beam or spatial trusses: The critical load factor allows you to 
evaluate whether or not the system is generally prone to instability (buckling and lateral-
torsional buckling). Moreover, you can apply imperfections under consideration of buckling 
shapes, and then use them for the calculation in RSTAB. 

RSBUCK provides the following special features: 

• Determination of several buckling shapes in one calculation run 

• Import of axial forces from RSTAB load cases or combinations 

• Option to take into account favorable effects due to tension 

• Optional consideration of stiffness modifications from RSTAB 

• Powerful equation solver for eigenvalue analysis according to subspace iteration method 
with user-definable parameters 

• Tabular output of critical load factors and corresponding buckling shapes 

• Visualization of buckling shapes with animation option in RSTAB graphical user interface 

• Print output in RSTAB printout report with automatic update in case of modifications 

• Preparation of the buckling shapes for the add-on modules RSIMP, KAPPA, STEEL EC3, 
STEEL BS, STEEL AISC, STEEL CS, STEEL GB, STEEL IS, STEEL SIA, ALUMINIUM, and TIMBER Pro 

• Data export to MS Excel, OpenOffice.org Calc, or as a CSV file 

We hope you will enjoy working with RSBUCK. 

Your team from DLUBAL ENGINEERING SOFTWARE  
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1.3 Using the Manual 
Topics like installation, graphical user interface, results evaluation, and printout are described 
in detail in the manual of the main program RSTAB. Therefore, the present manual focuses on 
typical features of the RSBUCK add-on module. 

The descriptions in this manual follow the sequence and structure of the module's input and 
results windows. The text of the manual shows the described buttons in square brackets, for 
example [Edit]. At the same time, they are pictured on the left. In addition to this, expressions 
used in dialog boxes, tables, and menus are set in italics to clarify the explanations. 

Furthermore, you find an index at the end of the manual. However, if you still cannot find what 
you are looking for, please check our website www.dlubal.com, where you can go through our 
FAQ pages by selecting particular criteria. 

1.4 Opening the Add-on Module RSBUCK 
RSTAB provides the following options to start the add-on module RSBUCK. 

Menu 
To start the program from the RSTAB menu, click 

Add-on Modules → Stability → RSBUCK. 

 

Figure 1.1: Menu: Add-on Modules → Stability → RSBUCK 

http://www.dlubal.com/
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Navigator 
Alternatively, you can open the add-on module in the Data navigator by clicking the entry 

Add-on Modules → RSBUCK. 

 

Figure 1.2: Data navigator: Add-on Modules → RSBUCK 

Panel 
If there are results available in RSBUCK, you can also start the add-on module by using the 
panel: 

First, select the relevant RSBUCK case in the load case list, which is located in the menu bar. 
Then click [Show Results] to graphically display the buckling shape. 

Now you can click the [RSBUCK] button to open the add-on module. 

 

Figure 1.3: Panel button [RSBUCK] 
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2.  Input Data 
When you open the add-on module, a new window appears. The navigator on the left lists all 
available module windows. The pull-down list above the navigator contains the stability cases 
(see chapter 7.1, page 29). 

When you open RSBUCK for the first time, the module automatically imports the created load 
cases and combinations. 

To open a window, click the corresponding entry in the navigator. To go to the previous or 
next window, use the buttons shown on the left. You can also use the function keys [F2] (next) 
and [F3] (previous) to browse through the windows. 

To save the results, click [OK]. Thus you exit RSBUCK and return to the main program. To exit 
the add-on module without saving the data, click [Cancel]. 

2.1 General Data 
In window 1.1 General Data, you define the parameters for the stability analysis. In most cases, 
you can specify all settings in this one window. 

 
Figure 2.1: Window 1.1 General Data 
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General 

 
Figure 2.2: Number of buckling shapes and application of axial forces 

Number of buckling shapes 

RSBUCK determines the most unfavorable buckling shapes of the model. With the number en-
tered in the input field, you specify how many shapes will be determined. The upper limit is 
10,000 of the lowest eigenvalues – provided that it is allowed by the number of possible de-
grees of freedom in the model as well as by the RAM capacity. 

Generally, the theory of the calculation method does not allow for an exclusion of the low ei-
genvalues from the analysis in order to determine only the higher eigenvalues. 

If negative critical load factors are displayed after the analysis, it is recommended to increase 
the values in the Parameters for Subspace Dimension accordingly (see description below). If the 
increments are too small, it is not possible to hide the negative eigenvalues to represent only 
the positive, realistic results. 

Import axial forces, nonlinear effects and initial deformations 

The drop-down list in this section contains all load cases, load combinations, result combina-
tions, and super combinations that are available in the current model. Select an entry whose 
axial forces and, if necessary, stiffnesses you want to take into account for the determination of 
the buckling shape. This load case or this combination should be calculated in RSTAB accord-
ing to the first-order analysis without stiffness reduction (material, cross-section, member). 

If you select a load-case or a load combination, the program imports axial forces as well as the 
stiffness boundary conditions from RSTAB. Thus, you can represent nonlinear effects like, for 
example, failing members, supports and releases, or member nonlinearities in RSBUCK. In case 
of result and super combinations, however, you can only consider the axial forces. RSBUCK 
then uses the minimum value min N (greatest compressive force) of the two extreme values. 

If results are not yet available for the selected load case or combination, they will be calculated 
automatically prior to the RSBUCK analysis. 

Alternatively, you can Define axial forces manually in table. If you select this option, RSBUCK 
shows the additional input window 1.2 Axial Forces (see chapter 2.2, page 12). There, you can 
specify for each member the axial forces N that are relevant for the determination of the criti-
cal load factors. 

The loads play an important role in the determination of buckling shapes and thus of buckling 
lengths because the buckling values depend not only on the structural model but also on the 
ratio of the axial forces and the total critical load Ncr. It is therefore recommended to define a 
load case with complete vertical loading (without wind) so that the majority of members are 
stressed by compression forces - after all, buckling lengths can be calculated only for members 
with compressive forces. Furthermore, the distribution of the loading in the entire system af-
fects the determination of the critical factors. 
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Options 

 
Figure 2.3: Options 

Consider favorable effects due to tension 

If the check box is selected, the axial tension forces acting in the model will also be taken into 
account in the determination of eigenvalues. Normally, those forces result in a stabilization of 
the model. 

Activate stiffness modifications from RSTAB 

With this check box, you decide whether the modification factors for the material, member, 
support, release, and cross-sectional stiffnesses are taken into account in the eigenvalue analy-
sis. These factors are described in the according chapters of the RSTAB manual. If this check 
box is selected, the program applies all stiffness factors of the load case or load combination in 
the RSBUCK analysis, taking into account the failure criteria.  

Thus, RSBUCK offers the control option to apply the stiffness modifications independent of the 
settings in RSTAB. It allows you to calculate, for example, axial forces of a load combination in 
RSTAB without reduction, and then to determine the critical loads in RSBUCK with the reduced 
material, member, and cross-section stiffnesses. 

If, however, the stiffness modification for the load case or the load combination is activated in 
RSTAB, this check box is unavailable: This ensures that the eigenvalues correspond to the 
model assumptions. 

If you determine the stability modes as a "characteristic" property of the model, you do not 
need to take into account the stiffness modifications. 

In the case of non-constant axial force in a member, which should be imported from 
RSTAB? 

The axial force distribution in a member is not always constant (for example, if a concentrated 
load is applied or if the automatic self-weight is considered in a column). The two option but-
tons in this section control whether RSBUCK uses the Mean value or the Most unfavorable value 
of the axial force for the analysis. The second option applies the maximum compression forces 
to the entire member. This may lead to lower eigenvalues. 
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Iteration Options 

 
Figure 2.4: Iteration Options 

The buckling shapes are determined by means of the eigenvalue of the entire system. The pro-
gram uses an iterative equation solver for the determination. Generally, you have to specify 
two break-off limits for iterative calculation methods: An exact solution can be approached ar-
bitrarily close without ever reaching it. 

Maximum number of iterations indicates the iteration step after which the calculation will break 
off − no matter if the problem is converging and, therefore, a useful solution is found. There 
can never be a solution for divergence problems. The Break off limit defines the moment when 
an approximate solution can be considered as an exact result for a convergence problem. 

Internal Member Partition 

 
Figure 2.5: Internal member partition 

In order to obtain a better approximate solution, you may have to refine the member parti-
tions. When you enter a value higher than 1, the program will divide the member. You can 
specify partitions separately for the member types Beam and Truss as well as for Members with 
tapering or elastic foundations. A higher accuracy of representation is often necessary for ta-
pered and foundation members. 

If you specify 1 for the member partition of a spatially defined single-span beam, the program 
calculates, at most, the six lowest eigenvalues. If you enter the partition value 2 to define a 
simple member division, you can already determine the 12 lowest eigenvalues. 

Parameters for Subspace Dimension 

 
Figure 2.6: Parameters for subspace dimension 

If RSBUCK, taking into account the specified number of iterations, does not find sufficient posi-
tive eigenvalues, the dimension of the subspace (that is, the number of eigenvalues) will be in-
creased automatically per Increment and a new number of buckling shapes will be calculated. 
This procedure continues until either the number of required positive eigenvalues or the Max-
imum number of increments is reached. 

This method of calculation is converging against the minimum absolute values of the eigenvalues. 
Hence, it may happen that the program determines, due to tension forces, for example, only six 
negative eigenvalues whose absolute values represent the minima. Now, you can determine the 
lowest positive eigenvalue by increasing the subspace. 

Comment 
You can enter user-defined notes describing, for example, the current stability case. 
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2.2 Axial Forces 
The program shows this window if you select a manual definition of axial forces in window 1.1 
General Data. You can enter the member axial forces directly in this window. 

 
Figure 2.7: Window 1.2 Axial Forces 

Members No. 
In this column, you specify the numbers of the members to which you want to assign the axial 
forces entered in column B. 

You can also select the members graphically. Click into the corresponding input field in column 
A to enable the selection function. Click the [...] button or press [F7] to jump to the RSTAB user 
interface. There, you can select the relevant members by clicking them one after the other. 

 
Figure 2.8: Graphical member selection in RSTAB 
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Axial Force 
In this column, you enter the member axial forces that are to be taken into account in the  
eigenvalue analysis. Enter compression forces always with a negative sign. 

The button [Import Axial Forces from RSTAB Load Case] below the table allows for the import 
of axial forces. In this way, it is possible to transfer automatically all members with axial forces 
of a load case, including corresponding internal forces. 

 
Figure 2.9: Dialog box Import axial forces from RSTAB 

If necessary, you can apply a factor to the axial forces. After clicking [OK], you can also manually 
modify the forces in the table. 

Comment 
In this column, you can enter user-defined notes to describe, for example, the axial forces. 
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3.  Calculation 
 

3.1 Check 
Before you start the calculation, it is recommended to quickly check if the input data is correct. 
To do this, click [Check]. 

If an inconsistency is detected, a warning appears showing the according information. 

 
Figure 3.1: Result of check 

3.2 Starting the Calculation 
To start the calculation, click the [Calculation] button.  

RSBUCK searches for the axial forces to be taken into account in the stability analysis. If no re-
sults are available for the load case, load combination, or result combination, the RSTAB calcu-
lation starts to determine the internal forces. 

You can also start the calculation in the RSTAB user interface. The dialog box To Calculate 
(menu Calculate → To Calculate) lists the add-on module cases as well as load cases and load 
combinations. 

 
Figure 3.2: Dialog box To Calculate 

If the RSBUCK cases are missing in the Not Calculated list, select All or Add-on Modules in the 
drop-down list at the end of the section. 
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To transfer the selected RSBUCK cases to the list on the right, use the [] button. Click [OK]  
to start the calculation. 

To calculate a stability case directly, use the list in the RSTAB toolbar. Select the relevant 
RSBUCK case in the list, and then click [Show Results]. 

 
Figure 3.3: Direct calculation of an RSBUCK stability case in RSTAB 

You then can observe the calculation process in a separate dialog box. 

 
Figure 3.4: RSBUCK calculation 

For the calculation according to the subspace method, the program runs the so-called Cholesky 
Decomposition, as shown in the figure above. It is used for solving the equation system during 
the iterative calculation in order to make new assumptions for eigenvalues and eigenmodes. 
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4.  Results 
Window 2.1 Buckling Lengths and Loads appears immediately after the calculation. 

The tables of the windows 2.1 to 2.3 show the results. To select a window, click the respective 
entry in the navigator. To go to the previous or next window, use the buttons shown on the 
left. You can also use the function keys [F2] and [F3] to browse through the module windows. 

To save the results, click [OK]. Thus you exit RSBUCK and return to the main program. 

Chapter 4 Results describes the results windows in their proper order. Evaluating and checking 
results is described in chapter 5 Results Evaluation, page 21. 

4.1 Buckling Lengths and Loads 

 
Figure 4.1: Window 2.1 Buckling Lengths and Loads 

The results for buckling lengths and loads are listed by member. The results of a certain mem-
ber can be shown quickly by using the navigator: Expand the list shown on the left, and then 
click the relevant Member No. RSBUCK then highlights the results of this member in the table. 

Member No.  
The results of the eigenvalue analysis are shown for all members of the model. Members with 
tension forces and failed members are marked accordingly. 

Node No. Start / End 
Every member is defined by a start and an end node. The numbers are shown in the columns A 
and B, respectively. 

Length L 
Column C indicates the geometric length of each member. 
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Shape No. 
The results are listed by buckling shapes. The following chapter, 4.2, describes the eigenvalues 
with the according buckling shapes. 

Buckling Length Lcr,y / Lcr,z 
The buckling length Lcr,y (or Lcr,u) describes the buckling behavior perpendicular to the "strong" 
member axis y (or u for unsymmetric cross-sections). Accordingly, Lcr,z or Lcr,v describe the de-
flection perpendicular to the "weak" member axis z or v. 

The buckling lengths Lcr are based on the member-specific buckling loads shown in column C. 
These loads are related to the respective critical load of the total model. Thus, the buckling 
lengths relate to the ratio of the member axial forces and the total critical load. For simple cas-
es, we know the buckling lengths as the EULER buckling modes 1 to 4. 

In some cases, the unfavorable buckling load of the system can be the critical load of an isolat-
ed member in the system, that is, a beam that is connected by a hinged support (see chapter 
8.3, page 40). This can be seen in the graphic of the corresponding buckling shape, because a 
sinusoidal wave is available only on this member. This means that the structure shows a so-
called local instability. The buckling lengths of all remaining members cannot be used for this 
failure case. Therefore, they must be taken from a "higher" buckling shape. The total model 
fails only there. 

Buckling Length Coefficient kcr,y / kcr,z 
The buckling length coefficients relating to the local member axes y and z or u and v describe 
the ratio of buckling and member length. 

L

L
k cr

cr =  

Equation 4.1: Buckling length coefficient kcr 

Buckling Load Ncr 
This table column shows for each member the critical axial force Ncr that was determined in  
relation to the respective eigenmode. Therefore, the individual buckling loads and the corre-
sponding buckling lengths must always be seen in the context of the respective critical load of 
the entire system. 
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4.2 Buckling Shapes 

 
Figure 4.2: Window 2.2 Buckling Shapes 

For each buckling shape, the table shows the displacements and rotations of the model's 
nodes. 

Node No. 
The buckling shapes are listed for the model objects defined in the RSTAB window 1.1 Nodes. 
Results in the member division points are not shown in the table. 

Shape No. 
The deformations are listed for each calculated eigenmode. 

Scaled Buckling Shape uX / uY / uZ / ϕX / ϕY / ϕZ  
The displacements listed in the columns C to E refer to the axes of the global coordinate sys-
tem and are scaled to the extreme value 1 of the total displacement. 

The columns F to H list the node rotations related to the scaled displacements. 

If the table shows only zero values for the scaled displacements, the reason is often to be 
found in large torsions within the members (see the figure below). These effects do not influ-
ence the displacements of the member ends. Therefore, the displayed buckling lengths and 
loads are not very conclusive. 
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Figure 4.3: Torsion of a thin-walled rectangular column 

4.3 Critical Load Factors 
The final results window contains information concerning the critical load factors of the model. 

 
Figure 4.4: Window 2.3 Critical Load Factors 
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Shape No. 
For each eigenvalue, the table shows the critical load as well as the magnification factors. The 
result rows are sorted by buckling shape numbers. 

Critical Load Factor f 
The table shows the critical load factor for every eigenvalue. If the factor is less than 1.00, this 
means that the structural system is unstable. A factor higher than 1.00 means that the loading 
from the available axial forces multiplied with this factor results in the system's failure due to 
buckling. 

According to DIN 18800 Part 2, a buckling load factor smaller than 10 requires a second-order 
analysis. 

If the table output contains a negative critical load factor, no stability failure occurs because of 
the tension forces. No conclusion about the expected buckling behavior is possible. 

Magnification Factor α 
The magnification factor is determined as follows: 

f
1

1

1

−
=α  

Equation 4.2: Magnification factor 

The magnification factor describes the relation between the moments according to the linear-
static and the second-order analysis. 

III MM ⋅α=  

where MI Moment according to linear static analysis, but taking into account the 
equivalent load for the deformation 

 MII Second-order moment 

Equation 4.3: Relation of moments 

Equation 4.3, however, applies only if the bending line due to the loading is similar to the 
buckling shape, and if the critical load factor f is greater than 1.00. 
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5.  Results Evaluation 
You can evaluate the eigenvalue analysis in different ways. To evaluate the results graphically, 
use the RSTAB work window. 

5.1 Results Windows 
First, you should evaluate the buckling load factors displayed in window 2.3 Critical Load Factors. 

A negative critical load factor indicates that no buckling failure could be detected because of 
the axial tension forces. That is: If the loading's direction of action (inverse signs) is reversed, a 
buckling failure would occur. To correct this, you can in some cases increase the number of 
buckling shapes to be determined. 

Critical load factors less than 1.00 are an indicator of the system's instability! 

 
Figure 5.1: Instable system 

Only a positive critical load factor that is higher than 1.00 permits to say that the loading due 
to the given axial force multiplied with this factor results in the buckling failure of the stable 
structural system. 

Window 2.1 shows the buckling length coefficients kcr for each member. The coefficients differ 
depending on the buckling shape. 

 
Figure 5.2: Buckling length coefficients kcr 

During the analysis, the program increases the axial forces iteratively until the critical load case 
occurs. From this critical load factor, RSBUCK determines the critical buckling load. In turn, the 
critical load allows conclusions regarding the buckling lengths and buckling length coefficients. 

If you want to show, for example, the governing buckling length coefficient kcr,y for the deflec-
tion perpendicular to the "strong" member axis y, you normally have to calculate several buck-
ling shapes. For square cross-sections, you obtain the same buckling lengths and buckling 
length coefficients in both axis directions. 

The buckling length coefficients for continuous members cannot be determined directly with 
RSBUCK. It allows for the evaluation of the results of the individual members only. The member 
with the lowest buckling load Ncr can be considered as governing for the entire set of mem-
bers. Then, the kcr values can be determined from the buckling length of this member and the 
total length of the set of members. 
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5.2 Results on the RSTAB Model 
You can also use the RSTAB work window for the results evaluation. 

RSTAB background graphic 
The RSTAB work window is useful for finding the position of the member in the model: The 
member selected in the results window is marked in the background graphic with the selec-
tion color. To locate the member, move the RSBUCK window to the side. 

RSTAB work window 
The graphical evaluation of the different buckling shapes is a good way to evaluate the stabil-
ity behavior of the model: Click [Graphic] to exit the RSBUCK module. Now, the buckling 
shapes are displayed graphically on the model in the work window of RSTAB like the defor-
mations of a load case. 

The current RSBUCK stability case is preset. The Results navigator controls which Global Defor-
mations of the buckling shapes are displayed graphically. 

 
Figure 5.3: Results navigator for RSBUCK 

In addition to the total deformation u, you can specifically display the displacement and rota-
tion components in each of the global directions. 

Similar to the display of deformations, the [Show Results] button switches on or off the display 
of the buckling shapes. The [Show Result Values] to the right is of minor importance for 
RSBUCK. 

You may deactivate the RSTAB tables, because they are of no relevance for the evaluation of 
the stability analysis. 

The panel is adjusted to the RSBUCK module. The panel's default functions are described in de-
tail in the RSTAB manual, chapter 3.4.6. The color scale tab in the panel appears only if the de-
formations are displayed with the option Cross-Sections Colored (see Figure 5.5). 
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In the Factors tab of the panel, you can select the buckling shapes. 

 
Figure 5.4: Selection of buckling shape in the Factors 

If the members that are prone to buckling are difficult to find, increase the Display Factors of 
the deformation in the Factors tab of the panel. The animation of deformations is another 
helpful function. To activate it, click the button shown on the left. 

You can control the results display in the Display navigator by selecting Results→ Deformation 
→ Members. By default, buckling shapes are shown as single-colored Lines. The two remaining 
options can be used to illustrate the buckling behavior. 

 

Figure 5.5: Display navigator: Results → Deformation → Members → Cross-Sections Colored 

You can transfer the graphics of the buckling shapes to the printout report (see chapter 6.2, 
page 27). 

To return to the add-on module, click [RSBUCK] in the panel.  
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5.3 Filter for Results 
The RSBUCK results windows allow for a selection by various criteria. In addition to this, you 
can use the filter options described in chapter 9.7 of the RSTAB manual. The options allow you 
to graphically evaluate the results of the stability analysis. 

In RSBUCK, you can also use the options of the Visibilities (see RSTAB manual, chapter 9.7.1) to 
filter the members for the evaluation. 

Filtering designs 
The scaled deformations can be used as filter criterion in the RSTAB work window. To go to the 
RSTAB window, click [Graphics]. The panel must also be available. If it is not available, you can 
switch it on by using the RSTAB menu 

View → Control Panel (Color Scale, Factors, Filter) 

or use the toolbar button shown on the left. 

The panel is described in chapter 3.4.6 of the RSTAB manual. Use the first panel tab (color 
scale) to specify the filter settings. This tab is not available for the line or cross-section display. 
Therefore, you have to select the Cross-Sections Colored option in the Display navigator (see 
Figure 5.5). 

In the panel you can specify, for example, that only scaled deformations greater than 0.55 are 
shown. This option makes it easier to locate the areas prone to buckling. 

Filtering members 
In the Filter tab of the control panel, you can specify the numbers of selected members to filter 
the display of the buckling shapes. The function is described in chapter 9.7.3 of the RSTAB 
manual. In contrast to the visibility function, the model is displayed, too. 

 

Figure 5.6: Member filter for buckling shape of a hall frame beam 
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5.4 Nonlinear RSTAB Calculation 

The main program RSTAB also offers the possibility to calculate the critical load factor of a load 
case or load combination. To do this, open the Edit Load Cases and Combinations dialog box. In 
the Calculation Parameters subtab of the load cases or load combinations, select the Calculate 
critical load factor check box. The check box is only available for the second-order analysis. 

 
Figure 5.7: Dialog box Edit Load Cases and Combinations, tab Calculation Parameters 

The Initial load factor k0 should not be too high to ensure that the first eigenmode is also de-
termined. 

RSTAB determines the critical load factor according to a nonlinear calculation method. Instead 
of a linear eigenvalue analysis, the loading is gradually increased by the Load factor increment 
Δk. If a particular load increment is reached, the structural system becomes unstable. Thus, the 
critical load factor is found and shown in the RSTAB table 4.0 Summary together with the origin 
of instability and the number of iterations. 
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Figure 5.8: RSTAB window 4.0 Summery 

This procedure allows you to consider all nonlinear elements like failing members or supports. 
However, only the lowest eigenvalue is calculated. Furthermore, the computing time is often 
longer than the time needed for a linear analysis with RSBUCK. 

Because of the different calculation methods, minor difference between the critical load fac-
tors from RSTAB and RSBUCK cannot be completely excluded. If the critical load factor accord-
ing to the second-order analysis significantly differs from the RSBUCK calculation, you should 
check whether or not the calculation parameters 

• favorable effect due to tension forces and 

• stiffness modifications from RSTAB 

have been taken into account in the same way in both cases. 
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6.  Printout 
 

6.1 Printout Report 
The creation of printout reports is similar to the procedure in RSTAB. First, the program gener-
ates a printout report for the RSBUCK results to which you can add graphics and explanations. 
In the printout report, you select the data of the stability analysis that will finally appear in the 
printout. 

The printout report is described in the RSTAB manual. Chapter 10.1.3.4 Selecting Data of Add-on 
Modules describes how you can prepare the input and output data of add-on modules for the 
printout. 

6.2 Graphic Printout 
In RSTAB, you can transfer every picture displayed in the work window to the printout report 
or send it directly to the printer. In this way, you can also prepare the buckling shapes that are 
shown on the RSTAB model for the printout. 

The printing of graphics is described in chapter 10.2 of the RSTAB manual. 

To print the current buckling shape, click 

File → Print 

or use the toolbar button shown on the left. 

 
Figure 6.1: Button Print Graphic in the RSTAB toolbar 

The following dialog box appears: 

 
Figure 6.2: Dialog box Graphic Printout, tab General 
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This dialog box is described in chapter 10.2 of the RSTAB manual. The RSTAB manual also de-
scribes the two other tabs, Options and Color Spectrum. 

You can move an RSBUCK graphic  anywhere within the report by using the drag-and-drop 
function. 

To adjust the graphic in the printout report subsequently, right-click the corresponding entry 
in the navigator of the report. By selecting the Properties option on the context menu, you re-
open the Graphic Printout dialog box where you can make the necessary modifications. 

 
Figure 6.3: Dialog box Graphic Printout, tab Options 
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7.  General Functions 
This chapter describes useful menu functions and export options for the results of the stability 
analysis. 

7.1 RSBUCK Analysis Cases 
Analysis cases allow you to evaluate different aspects of stability. For example, you can analyze 
the axial force influence from different load cases or load combinations with or without the 
consideration of tensile forces. 

To select the analysis cases of RSBUCK, you can also use the load case list in the RSTAB toolbar. 

Creating a new analysis case 
To create a new analysis case, use the RSBUCK menu, and select 

File → New Case. 

The following dialog box appears: 

 
Figure 7.1: Dialog box New RSBUCK Case 

Enter a Number (one which is not yet assigned) for the new RSBUCK analysis case. The Descrip-
tion helps you to select the right case in the load case list. 

Click [OK] to display the RSBUCK window 1.1 General Data where you can enter the new calcu-
lation parameters. 

Renaming an analysis case 
To change the description of an analysis case, select 

File → Rename Case. 

The following dialog box appears: 

 
Figure 7.2: Dialog box Rename RSBUCK Case 

In this dialog box, you can specify a different Description as well as a different Number for the 
analysis case. 
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Copying an analysis case 
To copy the input data of the current analysis case, select 

File → Copy Case. 

The following dialog box appears: 

 
Figure 7.3: Dialog box Copy RSBUCK Case 

Enter the Number and, if necessary, a Description of the new case. 

Deleting an analysis case 
To delete an analysis case, select 

File → Delete Case. 

The following dialog box appears: 

 
Figure 7.4: Dialog box Delete Cases 

You can select the analysis case in the Available Cases list. By clicking [OK], you delete the  
selected case. 
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7.2 Units and Decimal Places 
The units and decimal places for RSTAB and the add-on modules are managed together in one 
dialog box. In the add-on module RSBUCK, you can use the menu to define the units. To open 
the corresponding dialog box, select 

Settings → Units and Decimal Places. 

The dialog box known from RSTAB appears. RSBUCK is preset in the Program / Module list. 

 
Figure 7.5: Dialog box Units and Decimal Places 

You can save the settings as user profile to reuse them in other models. These functions are 
described in chapter 11.1.3 of the RSTAB manual.    
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7.3 Export of Results 
The results of RSBUCK can also be used in other programs. 

Clipboard 
To copy cells selected in the results tables to the Clipboard, press the keys [Ctrl]+[C]. To insert 
the cells for example in a word processor, press [Ctrl]+[V]. The headers of the table columns 
will not be transferred. 

Printout Report 
The data of the RSBUCK add-on module can be printed into the global printout report (see 
chapter 6.1, page 27) to export them subsequently. Then, in the printout report, click 

File → Export to RTF. 

The function is described in detail in chapter 10.1.11 of the RSTAB manual. 

Excel / OpenOffice 
RSBUCK provides a function for the direct data export to MS Excel, OpenOffice.org Calc, or the 
CSV file format. To use this function, select 

File → Export Tables. 

The following export dialog box appears. 

 
Figure 7.6: Dialog box Export - MS Excel 

When you have selected the relevant parameters, start the export by clicking [OK]. Excel or 
OpenOffice are opened automatically, that is, you do not need to open them first. 

 
Figure 7.7: Results in Excel 
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RSIMP 
If you want to use a stability mode in the RSIMP add-on module to generate equivalent imper-
fections or a pre-deformed initial model, you do not need to export the data. RSIMP allows you 
to select the relevant buckling shape No. as well as the RSBUCK Case directly in the correspond-
ing lists. 

 
Figure 7.8: Importing buckling shape in RSIMP 

STEEL EC3 / ALUMINIUM / KAPPA / TIMBER Pro 
The modules STEEL EC3 / SIA / BS / AISC / CS / IS / GB, ALUMINIUM, KAPPA, and TIMBER Pro pro-
vide the option to use the buckling length coefficients from RSBUCK directly for the members 
that you want to analyze. 

 
Figure 7.9: Selection of buckling length coefficients in the add-on module STEEL EC3 
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8. Examples 
 

8.1 EULER Buckling Mode 1 
Determine the critical load of a fixed column. Because of its type of loading and support  
conditions, the model corresponds to the EULER buckling mode 1. 

 

Figure 8.1: Model for EULER buckling mode 1 

Analytical solution 
The lowest critical load Ncr is determined according to the following equation: 

2
cr

2

cr
L

IE
N

π⋅⋅
=  

Equation 8.1 

The cross-section, defined as rolled cross-section HE-B 300, has the following second moments 
of area: 

 Iy = 25,170 cm4 

 Iz = 8,560 cm4 

Steel S235 is used as material. 

 E = 21,000 kN/cm2 

For a column that is fixed at one end and free at the other (EULER buckling mode 1), the buck-
ling length coefficient kcr = 2. 

The buckling load for the deflection perpendicular to the z-axis is determined as follows: 

kN54.443
)000,12(

560,8000,21
N
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Solution with RSTAB 
We create the column as 3D model. 

 

Figure 8.2: RSTAB model and loading 

We clear the selection of the automatic self-weight in the general data of the load case. Next, 
we apply the concentrated loading of 100 kN to the top node of the column. 

In the input window of RSBUCK, we enter the following data: 

 
Figure 8.3: RSBUCK window 1.1 General Data 
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After the [Calculation], RSBUCK shows a buckling load of 443.540 kN. 

 
Figure 8.4: RSBUCK window 2.1 Buckling Lengths and Loads 

Since we have increased the member partition accordingly, the value completely corresponds 
to the analytical solution. 

RSBUCK determines the following buckling shape: 

 

Figure 8.5: Buckling shape 
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8.2 Frame with K-Bracing 
Based on the 2D model shown in the figure below, we want to determine the buckling length 
coefficients of the model's frame column. The example is taken from [1], page 395. 

 

Figure 8.6: Steel frame model according to [1] 

Analytical solution 
The analytical solution is presented in [1], example 5.47. We assume a ratio of compression 
forces in the frame columns D2/D1 = 0.8, that is, the axial force in member 2 is 80 % of the axial 
force available in member 1. 

For our plane system, the following buckling length coefficients are determined in [1]: 

Member Buckling length coefficient kcr 

1 2.73 

2 3.07 

Table 8.1: Buckling length coefficients according to [1], page 397 

Solution with RSTAB 
We create a 2D model and define the members with the according HE-B cross-sections. We de-
fine the frame columns as member type Beam, and the frame beams and diagonal members as 
member type Truss (only N). 

We assign hinged supports to both column footings. 

To obtain the desired axial force distribution in the frame columns, we apply a concentrated 
load of 100 kN to the two topmost nodes, respectively. We apply further concentrated loads of 
25 kN to the frame column centers at the connection nodes of the diagonals. The automatic 
self-weight is not taken into account. 
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Figure 8.7: Distribution of axial force on the RSTAB model 

We set the RSBUCK input windows as follows: 

 
Figure 8.8: RSBUCK window 1.1 General Data 
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RSBUCK determines the following buckling length coefficients kcr: 

 
Figure 8.9: RSBUCK window 2.1 Buckling Lengths and Loads 

The results correspond very well to the analytical solution. 

The [Graphics] show the following buckling shape: 

 

Figure 8.10: Buckling shape 
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8.3 Frame with Hinged-Hinged Column 
We analyze the buckling behavior of a plane frame system according to Figure 8.11. 

 

Figure 8.11: Frame system and loading 

In this example, the lowest critical load factor (eigenvalue) is obtained on the isolated hinged-
hinged member No. 7. This means: At first, member 7 buckles locally; the total model fails only 
in the second eigenvalue. 

The two different buckling shapes shown in the figures on the following page provide infor-
mation about the buckling behavior. 

With an internal partition of 10 for beams, RSBUCK determines a critical load Ncr of 2080.94 kN 
for member 7. 

 
Figure 8.12: RSBUCK window 2.1 Buckling Lengths and Loads 

A calculation for the EULER buckling mode 2 confirms the value: 
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Equation 8.2 
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Figure 8.13: First buckling shape - local failure 

 

Figure 8.14: Second buckling shape - failure of entire system 
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